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Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.

Before using the equipment, please read this manual carefully to develop full familiarity with the functions and
performance of the graphic operation terminal you have purchased, so as to ensure correct use.

Please forward a copy of this manual to the end user.
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About the Manuals

The following product manuals are available. Please use this table as a reference to request the
appropriate manual as necessary.

Related Manuals

Manual No.

Manual Name (Model Code)

A870GOT Graphic Operation Terminal User’s Manual IB-66628
This describes the specifications and performance of the A870GOT main unit, as well as the (13J830)
hardware configuration, procedures for installing optional units, operation in on-line mode,
error codes, and troubleshooting guidelines.

SWONIW-ABGOTP Graphic Settings Software Package Operating Manual IB-66629

{Introductory Manual) (13JF21)
This manual is designed for the first-time user of the AB70GCT. It describes how to create
monitor screens with the ABGOTP, how to send monitor data to the A870GOT, and what
the various screen displays mean.

SWONIW-A8GOTP Graphic Settings Software Package Operating Manual IB-66630

(Startup Manual) (13JF22)
This describes the configuration of the ABGOTP system, precautions regarding the con-
figuration, and the specifications of the various functions, as well as the installation proce-
dures, startup procedures, screen configurations, and basic operation procedures.

SWONIW-A8GOTP Graphic Settings Software Package Operating Manual IB-66633

{Monitor Screen Creation Manual) (13JF25)
This describes procedures for creating monitor screens, monitor functions that can be
used with the A870GOT, procedures for setting the monitor functions, precautions to be
observed when creating monitor screens, and precautions to be observed when appropri-
ating conventional GOT monitor data for use with the A870GOT.

A870GOT Graphic Operation Terminal Operating Manual IB-66632

(Expanded Functions Manual) ' (13JF24)
This manual describes the operation procedures for using system monitor functions, monitor
functions for special function units, and the dedicated monitor screens used with the cir-
cuit monitor functions.

A8GT-MCA Memory Cassette with Built-in Circuit Monitoring Function User's Manual IB-66634

This manual explains how to install the circuit monitor cassette in the A870GOT. (13J831)
ABGT-RS4 RS-422 Serial Communication Unit User's Manual ' IB-66635
(Hardware Manual) (13J832)

This manual describes the names and settings for the various parts of the interface unit,
and how to install it in the A870GOT.

A7GT-BUS Bus Connection Interface Unit User’s Manual IB-66556

(Hardware Manual) (13JEQ92)
This describes the specifications of the bus connection unit, the names of parts, and how
to enter settings.




Manual Name

Manual No.
(Model Code)

A7TGT-J71AP23/R23 Data Link User’s Manual IB-66438
This manual contains the specifications for the MELSECNET (lI) Optical Data Link Unit/ (13JE26)
MELSECNET (I) Coaxial Data Link Unit, as well as the names and settings for the various
parts.

A7GT-J71AT23B Data Link Unit User’s Manual IB-66439
This contains the specifications for the MELSECNET/B Data Link Unit, as well as the names (13JE27)
and settings for the various parts.

ATGT-J71LP23/BR13 Network Unit User's Manual IB-66558
This manual contains the specifications for the MELSECNET/10 Optical Loop Network Unit/ (13JE94)
MELSECNET/10 Coaxial Bus Network Unit, as well as the names and settings for the various
parts.

MELSECNET, MELSECNET/B Data Link System Reference Manual IB-66350
This manual contains an overview of the MELSECNET (ll) and MELSECNET/B, as well as (13JF70)
the specifications, names of parts, and the various settings.

MELSECNET/10 Network System Reference Manual (For PC Networks) IB-66440
This manual contains an overview of the MELSECNET/10, along with the specifications, (13JE33)
names of parts, and the settings.

Computer Link Unit User’s Manual SH-3511

(Computer Link Functions/Printer Functions Manual) (13JE77)
This manual describes the unit settings, wiring, programming, troubleshooting procedures,
and other information concerning communication with peripheral equipment using the
dedicated protocol, the no-protocol mode and the bi-directional mode for the computer
link unit, as well as printer functions.

This manual can be used with the following computer link units:
A1SJ71UC24-R2, A1SJ71UC24-R4, A1SJ71UC24-PRF, AJ71UC24, A2CCPUC24,
A2CCPUC24-PRF, and A1SCPUC24-R2

AJ71UC24 Computer Link Unit User's Manual IB-66559

(Hardware Manual) (13JE95)
This manual explains the system configuration when using the unit, the unit specifications,
and the names of parts and the settings, and contains diagrams of the external dimen-
sions.

A18J71UC24-R4 Computer Link Unit User’s Manual IB-66582

(Hardware Manual) (13J805)

This manual explains the system configuration when using the unit, the unit specifications,
and the names of parts and the settings, and contains diagrams of the external dimen-
sions.
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1. Overview . MELSEC GOT

1. Overview

This manual describes the data transmission functions used to send created monitor data to the
A870GOT, as well as how to install the system program (circuit monitors, system monitors, and
other elements) and how to create and debug documents.

1.1 Configuration of the Manual

This manual consists of five chapters, which are described below.

Chapter 1

Describes the configuration of the manual,
how it is used, and abbreviations used in
the manual.

— Chapter 2

Describes the system configuration when
data is transmitted, debugging is done, and
documents are created.

Chapter 3

Explains how to upload and download
data, debug without using a sequencer,
and install the software package.

— Chapter 4

Explains the settings used when creating
documents, and how to create original docu-
ments using a general-purpose word pro-

Cessor.

— Chapter 5

Explains error messages which may ap-
pear when sending data or creating docu-
ments, and what steps should be taken
to correct the problem.
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1.2 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with five operating manuals. The GOT also
comes with a user’s manual. Manuals are categorized according to the purpose for which they
are used. Please read the manual that corresponds to your particular objective in order to become
familiar with the operations and functions of the software.

SWLINIW-AS8GOTP Operating Manual

SWONIW-AS8GOTP

; Personal
* Install the graphics software in the com- Operating computer
raphics
puter. software
e Start up the graphics software. <:| P
e Learn fundamental information and basic Startup manual

operations for the graphics software.

— SWONIW-ABGOTP
Clock display e Create simple graphics, monitor using the Operating
3 I ,
GOT, and learn the flow of a series of op-

erations. Introductory
manual

SWLINIW-ABGOTP

e Actually create screens for monitoring us- Operating

ing the GOT.
Drawing graphics Monitor screen
Sprite settings creation manual

e Edit the data which has been created.




1. Overview MELSEC GOT

SWLINIW-ABGOTP
Operating

¢ |nstall the OS program and communica-

tions driver in the GOT. Data transmission
e Download created graphics to the GOT. ﬁﬂgﬁcmm

¢ Debug graphics between the computer manual

and GOT.
Create data documents.

Circuit monitor

l_ﬂ
TYYY

System monitor

A870GOT Operating

e Monitor circuits.
¢ Monitor the system.
* Monitor the special unit.

Expanded
functions
manual

Special unit monitor

=

A870GOT User’s Manual

Install optional units (communications
unit, power supply unit) in the GOT. AS70GOT
Connect the GOT and sequencer CPU. User's
Find out how to attach the GOT and its
external dimensions.

Select a model.

H
O
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MELSEC GOT

1.3 Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

Abbreviation/Terminology

Contents

Graphics software

This refers to the SWCINIW-AS8GOTP.

Computer This refers to the peripheral device in which the graphics software
has been installed.
GOT This indicates the A870GOT.
Conventional GOT This indicates the A77GOT (S3/S5).

Canvas graphics

This indicates graphics and text data for still images.

Sprite

This refers to setting data used for moving images.

Screen data

This is the data specified for graphics and sprites, in units of one screen.

Common screen data

This is the data for the specified GOT type and screen switching device.

Comment data

This is character string data created in order to display comments
with the message display function.

Parts data This is graphic data registered in order to display graphics with the
part display function.
Title data This is title data that comes with each of the various screens.

Project data

This refers to all of the data that has been created, and all of the data
saved in the specified directory.

Symbol Contents
I | This indicates a command on a menu.
C_ ) This indicates a dialog box tab.
[ )| This indicates a displayed dialog box.
< S This indicates an item in a dialog box for which a setting can be
entered.
[ ] This indicates a dialog box command button.
POINT This indicates that the information is particularly important.
e This indicates an item which can be referenced in this manual.

This indicates an item which can be referenced in another manual.
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2. System Configuration MELSEC GOT

2. System Configuration

This shows the system configuration when transmitting data, debugging, and creating docu-
ments.

="

=

RS-232C cable A870GOT

Computer which runs Windows 3.1
( IBM PC/AT or )
IBM PC/AT compatible

Sﬁ%ﬂmfggg&, Printer cable ESC/P accommodates
D *1. Forinformation on the operating environment of the com-
] puter being used, and on procedures for installing and
starting up the graphics software, please refer to the

SWONIW-ASGOTP Operating Manual (Startup Manual).
System program *2.  Printers which run under the Windows environment can
SWONIW-ASSYSP . e . - .
be used without modification. Mitsubishi Electric Cor-
poration recommends the following printers:
* Made by Epson
] MJ-800C
— MJ-900C
LP8500/3000/1500
5 " ¢ Made by Canon
Special unit monitor data BJC-600J
SWLINIW-ABGMDP *3, See Appendix 2 for a diagram showing RS-232C cable
connections.
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3. Communications MELSEC GOT

3. Communications

3.1 Installing the System Program (0S)

When is this function used?

e The system program is installed in the GOT main unit when you are ready to run circuit
monitor functions, system monitor functions, and special unit monitor functions.

1. Select | OS Install | on the Communications menu.
2. The “OS Install” dialog box is displayed.

~Source path

|C:\ABGOTP\OS | [Browse] | Default |

0S name: Comm. driver:
Standard monitor . s |Nnt install |£|

System monitor
Sp. unit monitor
Ladder monitor

+] Size [byte] : 972348

POINT

When the system program is installed, it will over-
write any system programs which have already been
installed previously.

Iltem to Set Description of Setting

“Source path” ¢ Specify the drive and path containing the system program file.
e Clicking on displays the file name reference dialog box.
e Clicking on | Default | displays the OS directory contained in the

directory specified when the program was installed.
functions i :
manual | “OS name” Select the system program to be installed, by placing a check mark
‘ in the box.
Browse }

“Comm. driver” . Specify the communications driver that corresponds to the commu-

nications cassette being used.

3-1



3. Communications MELSEC GOT

3.2 Downloading Data

3.2.1 Downloading Monitor Data

When is this function used?

¢ Monitor data is downloaded when the created monitor data is written to the built-in memory
in the GOT.

1. On the Communications menu, select | Download | and then | Monitor Data |

2. The “Monitor Data Download” dialog box is displayed.

= Monitor Data Download

Setting | Base | window |  Others
I-Object

......................

@® glldata O Select data Download

[] Delete old monitor data

Project title:
GOT Type: ABFOGOT-TFT. STH
Transfer size [byte): 104108 Author:

POINT

If the same data as that being downloaded already
exists in the built-in.memory in the GOT, the previ-
ous data will be overwritten.
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Item to Set Description of Setting

“Object” Using the radio button, select the data to be downloaded.

“Delete old monitor data” | Clicking on after selecting the data with the check box
displays a confirmation dialog box like that shown below.

= SWONIW-ASGOTP

After deleting the user monitor data of the memory,
do yo download data?

No I | LCancel |
Yes : Deletes monitor data already in the GOT built-in memory
before downloading new data.
: Downloads data without deleting data already stored in

the memory.
Cancel| : Interrupts the downloading process and returns to the
screen window.
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3. If “Select” is chosen under “Object”, clicking on the tab name displays the screen shown be-
low.

Select the objects to be downloaded on the various screens.

— Monitor Data Download Items which were .created or modified in
. the Base screen window are downloaded

Window

here, along with setting items which are
common to all of the windows.

Object No.:

1 Initial screen

2 Demo-menu

3 Opesator panel

4 Multi-language

5 High speed monitor

= Monitor Data Download Items which were created or modified in

Setting Others the Window screen window are down-
Object No.: loaded here, along with setting items which

1 Promotion meno |Do-m|oad| are common to all of the windows.
[0 5 Graph window

= Monitor Data D load .
Parts data created on the screen window,

Sefting part names, comments which have been

Other created, and setting items which are com-
Parts mon to all of the windows are downloaded
here.

Common setting
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« Contents specified using [ Setting] and then [Project ] on the Common Settings menu cannot

be downloaded.

e The following contents are displayed in the lower part of the “Monitor Data Download” dialog
box.

Display Contents Displayed

“Project title” Displays contents specified using| Setting [Jand then| Project [Jon the

“By” Common Settings menu

“GOT Type” Displays contents specified using | GOT Type | on the Common Set-

tings menu

“Size (byte)” Displays the size of the monitor data being transmitted

POINT

While data is being downloaded, all GOT functions currently running are stopped. When all of
the data has been downloaded, the stopped functions resume automatically.
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3.2.2 Downloading Special Unit Monitor Data

When is this function used?

» Special unit monitor data is downloaded when data is written to the built-in memory in the
GOT.

1. On the Communications menu, select [ Download|] and then | Special Unit Monitor Data].

2. The “Special Function Module Data” dialog box is displayed.

Spazcial Function Module Dafa

CliDelete old special function data:

Project fitle:
GOT Type:  AB70GOT-TFT, STN
Size (byte): 32894684

POINT

if the same data as that being downloaded already
exists in the built-in memory in the GOT, the previ-
ous data will be overwritten.

ltem to Set Description of Setting

“Delete old special | Clicking on after selecting the data with the check box
function data” displays a confirmation dialog box like that shown below.

= SYONIV-ABGOTP

After deleting the user monitor data of the memory.
9 do yo download data?

: Deletes special function data already in the GOT built-in
memory before downioading new data.

: Downloads data without deleting data already stored in
the memory.

: Interrupts the downloading process and retumns to the

screen window.

_<
IEg




3. Communications MELSEC GOT

3. Running the downloading function initiates downloading of special unit monitor data saved in

the drive and directory specified by under | Options || on the Project menu.

4. Al of the special unit monitor data which has been installed is downloaded at one time.

5. For information on installing special unit monitor data, please see the manual noted below.
A870GOT Graphic Operation Terminal Operating Manual (Expanded Functions Manual)
1B-66632

POINT

While data is being downloaded, all GOT functions currently running are stopped. When all of
the data has been downloaded, the stopped functions resume automatically.




3. Communications MELSEC GOT

3.3 Uploading Data

When is this function used?

¢ Data is uploaded when monitor data which has been saved to the built-in memory of the
GOT is to be read to a graphics software file.

1. Select |Upload | on the Communications menu.

2. The “Monitor Data Upload” dialog box is displayed.

- Monitor Data Upload

~Upload destination path

| | [Browse|

~ Object Password:

@ All data [ ]
(O Select data

item to Set Description of Setting

“Upload destination path”| ® Specify the drive and path to which the data is to be uploaded.
» |f a file which already exists is specified as the upload destination,
the following message dialog box is displayed.

- Browse

CAABDEMOYABGOTP.GOT
This file already exists.

Replace existing file?

¢ [f the file currently being edited is specified as the upload destina-
tion, the following message dialog box is displayed.

SWONIW-A8GOTP

@ The project under the edit cannot be selected.

“Object” * The data to be uploaded is selected using the radio buttons.
* Choosing “Select data” and clicking on | Read title| reads out the
titles of monitor data saved to the built-in memory of the GOT.

“Password” If a password has been specified for data transmission, enter the
specified password here.

3-8
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3. When “Select data” is chosen under “Object” and the monitor data has been read out from the
built-in memory of the GOT by clicking on [Read title |, clicking on the tab name displays a
screen like that shown below. This screen can then be used to select the data to be uploaded.

Moniter Data Upload
Setting L Yindow

This uploads the data of the specified Base

Base N screen, as well as parts data, comments,
2 <

2ase o and setting items common to all of the win-

1 Initial screen Eﬂl"_ad_l dows.

2 Demo-menu

3 Operator panel
4 Muli-Hanguage

5 High speed monitor
13

OO0 0NKIK X

= Monitor Data Upload

Window No.:

1 Promotion menu
[0 b5 Graph window

This uploads the data of the specified Win-
dow screen, as well as parts data, com-
ments, and setting items common to all of
the windows.

POINT

(1) Parts data, comments, and setting items common to all of the windows are always up-
loaded.

(2) While data is being downloaded, all GOT functions currently running are stopped. When
all of the data has been downloaded, the stopped functions resume automatically.
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3.4 Reading Information From the Built-in Memory

3.4.1 Checking Information in the Built-ihn Memory

When is this function used?

e This function is used when you want to confirm data information which has been written to
the built-in memory of the GOT.

1. Selecting [ Memory Informationj] on the Communications menu displays the “Communicating”
dialog box shown below, and reads out the information in the built-in memory of the GOT.

ommunicating with GOT.Please wait a moment

2. After all of the information has been read out, the “Memory Information” dialog box is displayed.

= Memory Information

Base I Window | Special Maodule | 0S I

1 Initial screen + Close ]

O
[l 2Demo-menu
] 3 Operator panel [ Heip |

l Delete all I Delete l

Project Title:

Drawing Version: E1.9

—rre— e I

Memory size: I 2.048 K byte
User area size: I 384 K byte Available size: I 234 K byte
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3. Clicking on a tab name switches the information data displayed.

= Memory Information
Base | Window I Special Module | QS |

Window No.:

[0 1 Promotion menu +] [ cClose |
[0 5 Graph window

+ Hel

| Delete all I Delete I

Project Title:

Drawing Yersiono E1.9

Memary size:| 2,048 K byte
User area size: I 382 K byte

Available size: I 234 K byte

Memory Information

Base |  window [ Special Module | 08 |

—

Special funciton data No.:

[] 170 AD75P Operation Monitar Screen
[J 171 AD75P 1/0 Monitar Screen

[] 172 AD75P Basic Parameter 1 IE

Close

| Delete all I Delete I

Project Title:

Drawing Version: E38

Memory size:l 2.048 K byte
User area size: I 384 K bute Available size: I 234 K bwyte

3-11
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Memaory Information
Base T_ Window Special Module

05 name:

[] standard monitor
[] system monitor
(] Sp. unit monitor
[] Ladder monitos
[JBus

+

Memory size: I 2,048 K byte
Uszer area size: I 384 K byte Available size: I 234 K byte
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3.4.2 Deleting Information From the Built-in Memory

When is this function used?

o This function is used when you want to delete data from the buitt-in memory of the GOT.

1. Selecting [Memory Information [] on the Communications menu displays the “Memory Informa-
tion” dialog box.

3 For further information, see Section 3.4.1.

Memory Information

Base Window T Special Module T QS
POINT 1 Initial screen + | Close I
“Standard monitor” 2 Dema-menu

cannot be deleted. 3 Dperator panel

| Delete all I Delete I

Project Title:

Drawing ¥ersion: E1.9

Memory size:l 2.048 K byte
User area size: l 384 K byte Available size: I 234 K byte
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ltem to Set Description of Setting
“Delete All” Clicking on | Delete All} displays the following screen.
SWONI-ABGOTD
Do you delete all user data
including parts and comments?
(e | Mo |
Yes| : Deletes all of the data (parts data, comments, common set-
tings).
: Interrupts the deletion process and retumns to the screen
window.
“Delete” e Select the data to be deleted from the list box (more than one item

may be selected).
¢ Clicking on displays the following message dialog box.

@ Delete:  sxxsxxxxsxxes

[ ][ veoa |[ % |[om]

: Deletes only one data item, and displays the same dia-
log box for the next data item.

: Deletes all of the data selected in the list box.

: Goes to the next data item selected in the list box with-
out deleting the first one, and displays the above dia-
log box again for the next item.

: Interrupts the process of deleting data from the built-in
memory and retums to the screen window.

EE

o o

® o
=
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3.5 Reading Information From a Memory Card

3.5.1 Checking Information on a Memory Card

When is this function used?

¢ This function is used when you want to check the information contained on an IC memory
card installed in the GOT.

1. Selecting | Memory Information ﬂon the Communications menu displays the “Communicating”
dialog box shown below, and reads out the information on the memory card installed in the
GOT.

ommunicating with GOT.Please wait a moment

2. After all of the information has been read out, the “Memory Information” dialog box is displayed.

Memory Card Information

Base I “Window T Special Unit

1 Imhial screen I Close I

2 Demo-menu

3 Operator panel

4 Multi-language

5 High speed monitor
13

Hel

Project title:

Drawing version:

Card size: I 2.048 K byte File area: I 0 K byte
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3. Clicking on a tab name switches the information data displayed.

= Memory Card Information
Base | Window ' Special Unit _]

Window No.:

....... 1 Promotion menu + | Close |
5 Graph window

T

Project Title:

Drawing Version- E1.9

Card size: I 2,048 K byte

File area: I 0 K byte

== Memory Card Information

Base Window Special Unit

I Special function data No.:

£ 170 AD /5P Dperation Monitar Screen + | Cloze |
171 AD79P 170 Monitar Screen

172 AD75P Basic Parameter 1

173 AD75P Basic Parameter 2

Project Title:

Drawing Yersion: E38

Card size: I 2.048 K byte

File area: I 0 K byte
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3.5.2 Formatting Memory Cards

When is this function used?

o This function is used when you want to format an IC memory card installed in the GOT.

1. Selecting | Memory Informationj on the Communications menu displays the “Memory Informa-

tion” dialog box.

(7 For further information, see Section 3.5.1.

= Memory Card Information

' Base I Window |

Special Unit

1 Imihial screen +

2 Demo-menu

3 Operator panel

4 Multi-language

5 High speed monitor
13

I Close I

Project title:

Drawing version: E1.9

Card size: I 2.048 K byte

File area: I 0 K byte
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Item to Set

Description of Setting

e Clicking on ' displays the following screen.

Card size 2048 [ Kbste

Flearea: [0 [§ Kbse
O File arca

e Inthe spin boxes, specify the memory card size and the file area.

@ : Displays the dialog box shown below.

screen window.

SWONBAY-A3GOTP

Do you format the memory card?
(Do you format fille area?)

| i'\'rle;} || No |

Yes| : Formats the IC memory card.

window.

Cancel| : Interrupts the formatting process and returns to the

, E : Interrupts the formatting process and returns to the screen
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3.6 Debugging Without a Sequencer

Changes can be made to the device value, and any changes made to the value can be checked,
simply by connecting the GOT main unit to the computer being used.

This makes it easier to debug design rooms and other data in advance.

Check of change in screen display

Debug using touch switch operation

Bit Device Word device

Mnnltor devmej I‘ Set device
[

'Devlce value
CtCi  Setv

NO TR WN =D
copooooOe
-
cocoooo®
=====eeai
P
NONAWN=SE
cooocooal
ccomeoaall
coocooooo¥
coccoconecl

Change in device value
Check of device value change

POINT

(1) The various device values set when debugging is carried out are written to a file, so default
values do not need to be set the next time debugging is done.

(2) The sequence program is not run with this function. (The status is the same as when the
sequencer CPU is stopped.)

(3) The table below shows devices which can be debugged, and the device ranges.

Device Setting Range
O~1FFF
O~1FFF
0~-8191
0-2047
O~1FFF
0~8191
O~1FFF
0~255
0~255

Bit device

Word device

Timer/counter

old|s|o|lwm|n|z|<]|x

(4) Values for word devices can be set within a rahge of -32768 ~ +32767.
(5) The debugging function for the graphic software can only be used locally.




3. Communications MELSEC GOT

3.6.1 Debugging Operation Flow

C Debugging carried out without sequencer

e Creating a monitor screen
7 See manual on creating
. monitor screens.
Preparation:
. . ¢ Connecting computer and GOT
install OS in GOT and download project data 3 See Chapter2.
l o Downloading monitor screens
(5 See Section 3.2.1.
Select [Debug ] on Communications menu w
“Initial Set” dialog box is displayed
\ 4 1
See Section 3.6.2.

OK Read file

“Debug” dialog box is displayed

Connect |..... Communication with GOT begins

> Monitor device settings ~ freseseemeemesenneseneae See Section 3.6.3.

'

Set device settings
l See Section 3.6.4

- Shift to GOT screen
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3.6.2 Communicating With the GOT Main Unit

When is this function used?

¢ This function is used to set up communications between the GOT and the computer in
order to debug data.

1. Selecting | on the Communications menu displays the “Initial Set” dialog box.

= Initial Set

Device value
 Not change

@ Initial
QO Device file

I |
Sampling time: E@ (sec)

Iltem to Set Description of Setting
“Device value” ¢ Use the radio buttons to select the device value used when the
debugging function is started up.
o |nitial.....ceeevenee. This initializes the device value and starts the
debugging function.

¢ Device file ........ This starts the debugging function using the
device value written to the specified device file.
7 See Section 3.6.5.

“Display Timing” Set the display timing for the device value when the bit device is in
on/off status during communication with the computer to a value
between 1 and 10 seconds.

2. Clicking on displays the “Debug” dialog box.

Bit Device | Word device Timer/Counter

~ Monitor device Set device
| &3l |

~Device value
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Clicking on the tab name displays the “Word device” and “Timer/Counter” debugging dialog boxes.

| Bit Device

T

Word device

— Monitor device

|

r Timer/Counter

|‘Set device
|

| l_P_ev. I

- Device value

Bit Device

Word device

- Monitor device

|

diill

Timer/Counter

Eet device

[e==]

~Dewvice value
Ct€Ci Setvy

Prev

Ct Ci Sety Prev

Initial set...

3. Clicking on initiates communications between the GOT and the computer.

While communications are being carried out, the foIIoWing are disabled and cannot be se-

lected: [Connect], [File write] , [Intial set], and [Close| .
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3.6.3 Specifying the Device to be Monitored

When is this function used?

¢ This function is used to display the device value in order to change a device and check any
changes that have been made.

1. Selecting [Debug]] on the Communications menu brings up the initial settings entered in the
“Initial Set” dialog box and displays the “Debug” dialog box.

[ See Section 3.6.2.

2. Clicking on [Connect ] in the “Debug” dialog box initiates communications between the GOT
and the computer. .

[C7 See Section 3.6.2.

Bit Device I Word device | TimerfCounter |7
~ Monitor device I'Set device

L 1 (Bexl]

~Device value

eY

e

Initial set...

Close
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3. Clicking on under the “Monitor Device” parameter displays the “Device” dialog box.

Device type: r
NW No: [0 4]

Station No.: O Host O l]thers

Device name:
Device No.: % Block No.: m%

Bit position: m% Unit top 1/0 No.: E-E

ltem to Set Description of Setting
“Device name” e Select the device to be monitored from among those in the list box.
 The following devices can be selected:
- For a bit device ............. X, Y,M,F,B
- For a word device ......... D,W

- For the timer/counter ....T, C

“Device No.” Using the spin box, set the number of the device to be monitored.

POINT

In the “Device” dialog box under the debugging function, no settings other than “Device name”
and “Device No.” need to be entered.
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4. Example of monitor device display screen

Bit device

Bit Device

~ Monitor device

[0-FF BOOOO

cood
0001
0002
o003
0004
0005
0006
o007

~Device value

| | Dev. I

Y 0000
Y 0001
¥ 0002
Y 0003
Y 0004
Y 0005
Y 0006
Y 0007

EZTIXIIIX
NN =0

Disconnect

Word device

Bit Device

~Monitor device

Word device

Timer/Counter

[0-FF D20

20
21
22
23
24
25
26
27

~Device value

I |’Set device
I

—N-N-N-N-N-N—N—
= B B e i L —

SN NeWN=Q

cooeoeoe®
LR RERR

IUQQUQQQQ

0000
gon
o002
0003
0004
0005
0006
0007

The specified device is shown at
the top, in eight columns and four
rows.

The specified device is shown at
the top, in eight columns and
three rows.

Clicking on [->HEX] /| ->DEC]|
switches the display between
hexadecimal and decimal values.
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Timer/Counter

The specified device is shown at
the top, in eight columns and two
rows.

Bit Device ‘Word device Timer/Counter

- Monitor device | |’Set device

|0-FF CO ,r

~Device value
Ct Ci

w
L3
%
n
)
2
<

Initial set...

PROEPAPEO
NO U e WA =D
cecoeoooQ
coococoo
- -
NI R WN =
cooooooofd
cocoocosooel
cooooooe
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3.6.4 Changing Device Values

When is this function used?

e This function is used when you want to change the current value of the specified device.

1. Selecting [Debug|] on the Communications menu brings up the initial settings entered in the
“Initial Set” dialog box. Clicking on [OK] displays the “Debug* dialog box.

3 See Section 3.6.2.
2. Clicking on under the “Monitor Device” parameter displays the device to be monitored.
[T7 See Section 3.6.3.

3. Clicking on under the “Set device” parameter in the “Debug” dialog box displays the
“Bit/Word Set” and “Timer/Counter Set” dialog boxes.

Timer{Counter Set Bitfvord Set

- Device
|7

- Contact{CY
@® ON O oF
- Coil[Ci)
@® ON QoF

rValue j

Set m Present: ﬁ_%l

Item to Set Description of Setting
Bit/ “Device” | e Clicking on displays the “Device Set” dialog box.
Word Set (T3 See Section 3.6.3.
dialog box
“Bit” * Using the radio buttons, select whether the specified bit device is
on or off.
e If a word device has been specified as the device, “Bit” cannot be
selected.

“Word” e Using the spin box, set the value of the specified bit device.

« Clicking on|->HEX|/[->DEC|switches the display between hexa-
decimal and decimal values.

o If a bit device has been specified as the device, “Word” cannot be
selected.

Timer/ “Device” |  Clicking on displays the “Device Set” dialog box.
Counter Set U3 See Section 3.6.3.
dialog box

“Contact” | ® Using the radio buttons, select whether the contact/coil of the
“Coil” specified device is on or off.

“Vaiue” e Using the spin box, set the setting values/current value of the speci-
fied bit device.

3-27
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4, Clicking on displays the “Debug” dialog box.

Bit Device Word device TimerfCounter

- Monitor device : Set device '
[0-FF D40 | (Dev. ] [WFF D44 ] |
- Device value
D 40 oD 20 100 D 0 9 -

D 41 oD 21 0D 1 0
D 42 0D 22 320000 2 0
D 43 oD 23 0D 3 m
D 44 3022 D 24 0D 4 _
D 45 0D 25 5000D 5 [_Close ]
D 46 gD 26 0D 6

D 47 oD 27 0D Fi

5. The monitor screen of the GOT main menu changes to show the device value sent from the
computer.

6. Clicking on cancels communications with the GOT.

POINT

(1) While debugging is in process (communications with the GOT are in progress), the following
are disabled and cannot be selected: [Connect], [File write] , [Initial set|, and[Close] .

(2) The display timing for the device value is set in the “Initial Set” dialog box. The speed
depends on the processing speed of the computer being used, however, so in some
cases the speed may be slower than that specified for the display timing.
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3.6.5 Saving the Device Value

When is this function used?

e This function is used when you want to save the device value specified in the “Debug”
dialog box under & file name.

1. Display the “Debug” dialog box.
U5 See Section 3.6.2.

2. Clicking on displays the “Save As” dialog box.

File Name: Directories:

Hev J a:\debug
= a\

Save File as Type: Drives:
DEVICE ] (=a

ltem to Set Description of Setting
“Drives” « Select the drive to which the file is to be saved from among those
in the list box.
“Directories” » Specify the directory name for the file to be saved in the list box.

(The file extension is fixed as “*.dev” and cannot be changed.)

“File Name” * Input the desired file name in the text box.
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3.6.6 Reading Device Files

When is this function used?

e This function is used when you want to read out the device value saved under a file name
.in the “Debug” dialog box.

1. Selecting [Debug]] on the Communications menu displays the “Initial Set” dialog box.

e mitalSet |
~Device value

{ Mot change m

O Initial

................................

|
S ampling time: E@ {sec]

Item to Set Description of Setting

“Device value” e Select “Device file” using the radio button, and input the file name
under which the device value was saved in the text box.

¢ Clicking on displays the “Browse” dialog box.

2. Clicking on | Initial Set | in the “Debug” dialog box displays the “Initial Set” dialog box.

Bit Device Word device / Timer/Counter
~ Monitor device Set device
|0-FF D40 | |_Dev._] [[U-FF D44 | [[Dev. |
- Device value
D 40 0D 20 100 D 1} 9 -
D 41 0D 2 oD 1 0
D 42 0D 22 32000 D 2 0 File wite.
D 43 oD 23 0D 3 900 —
D 44 3022 D 24 0D 4 0
D 45 0D 25 S5000D 5 0
D 46 0D 26 0D 6 1]
D 47 0D 27 0D 7 0
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4. Document Creation

4.1 Creatingf Document

Original documents can be created by taking the contents of the data specified in the graphics
software and outputting them to a printer or to a file which is then read using a general-purpose
word processor.

4.1.1 Document Creation Flow
Data is output directly to a (Data is output to a file. J Data is output to the Preview
printer connected to a periph- T screen.
eral device. T
(Data contents are outputto a The contents of the data are The contents of the Preview screen
@rinter. output to a file. ) are output to a printer or file.
[Print]] is selected on the [Print]] is selected on the | is selected
Project menu and the “Print” Project menu and the “Print” on the screen menu and the
dialog box displayed. dialog box displayed. preview screen displayed.
(7 seeSectonat2 | | | l
| is selected and the is selected and the l [Print]] or[Save]]is selected on
page number, black/white re- page number, black/white re- | the File menu.
versal, margins, and other pa- versal, margins, and other pa- I
rameters specified. rameters specified.
________ J
[ 5 seeSection4.1.3. | | |
v N
I Print Setup |is selected and | | rint | Save ||
|| the printer to be used, paper |
size, and printing orientation |
specified.
o — =
(5 SeeSectiondia. | | . T
I v v I v
| Bata to be printed is selected. | The data to be output to the | The name of the file to which
file is selected. the data is output (saved) is
r - |l = _____.| specified.
<
L ) v l

N
( Printing is carried out. )

( Data is output to the file. ) ( Data is output to the file. )

General-purpose word processor

4-1
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41.2 Specifying the Options for the Output Destination

When is this function used?

e This function is used when you want to set the options used with the output destination
(printer or file) when a document is created.

1. Selecting [Print]] on the Project menu displays the “Print” dialog box.
[ See Section4.1.4.

2. Selecting displays the “Option” dialog box.

- Page No.

@ Add(-p-) Initiak: 1 [

{ Mone

rImage data——— | [ Sprite informatinnj
@ Reverse @ List

{ Normal 7 O Details

Left:

Right:

ltem to Set Description of Setting

“Page No.” « If page numbers are to be added, the radio buttons are used to
specify the type of numbering and the initial page number.

“Image data” e The radio buttons are used to determine whether the screen im-
age is to be normal or reversed when output to the printer or file.

“Sprite Information” « The radio buttons are used to select the output format for the
sprite information.
S I Outputs the devices and positions.
- “Details” ...... Outputs detailed contents such as conditions, for-
mats, displays, and positions.

“Margin” e The spin buttons are used to specify the margins used for printing.
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4.1.3 Selecting the Printer Type

When is this function used?

e This function is used to specify the type of printer, the paper size, and the orientation ofthe
printing.

1. Selecting [Print]] on the Project menu displays the “Print” dialog box.
5 See Section 4.1.4.

2. Selecting | Print Setup | displays the “Print Setup” dialog box.

Cancel

{currently EPSON LP-3000 on LPT1:)
 Specific Printer: Dptions...
[EPSON LP-3000 on LPT1:

~Orientation— | [ Paper
. @ Portrait Size:  |A4 210 x 297 mm

{ Landscape Source: Ilplli!i.lflz

ltem to Set Description of Setting

“Printer” » The radio buttons are used to select the type of printer to be used.
» “Specific Printer” can be selected and the drop-down menu used
to specify a type of printer different from the standard printer.

“Paper” e The drop-down menus are used to select the paper size and the
method by which paper will be supplied.

“Orientation” e The radio buttons are used to select whether printing will be done
in the vertical or horizontal direction.

POINT

The contents of the “Print Setup” dialog box may vary depending on the printer driver in the
Windows version being used.
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41.4 Specifying the Data to be Output to a Printer/File

When is this function used?

e This function is used to specify the data to be output to a printer or file.

1. Select | Print[] on the Project menu.

2. The “Print” dialog box is displayed.

Basze
Window
Comment
Paits

[J Device list.

~ Output

@ Printer

O Files

=
- ltem

Project information

| Help |

Item to Set

Description of Setting

“ltem”

file.

fied.

e Using the check boxes, select the data to be output to a printer or
* Clicking on “Details” enables detailed printing items to be speci-

“Print tem Selection [Project Information]” dialog box

Print item Selection (Project Information]

ltem
Base title lst
Window title kst

(Continued on next page)
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“Print Item Selection [Base]” dialog box

- Print item Selection[Base]

——
[ Detailed explanation
Sprite information
Print screen: Range——————— ]

O canvas swtNo: [ |[Hee |
[ image End No.: 1024

[ Device How to print screen(per page]

[ imagesDevice @ 1 screen O 3 screen:

“Print ltem Selection [Window]” dialog box

= Print lem Selection(Window)

- tem
[ Detailed explanation
X Sprite information
Print screen: Range—

[ Canvas Stant No.: EE E
3 Image End No.: 1024

[ pevice How to print screen(per page)

T Image+Device [O1screen @ 3 screen:

¢ In the “Print ltem Selection [Base]” and “Print ltem Selection [Win-
dow]” dialog boxes, the starting and ending screen numbers can
be specified, using the spin boxes.

e In the “Print ltem Selection [Window]” dialog box, the method of
printing hard copies can be specified.

- “1 screen” ...... Prints each screen on its own page.
- “3 screen” ...... Prints three screens on one page.
“Output” * The radio buttons are used to selected the destination to which

the data is to be output.
e The file names used when data is output to a file are listed below.

Data ltem File Name
Project Information PROJECT.TXT
Base screen | Detalled description of screen BASE.TXT
information  [Sprite information BASE.TXT
Canvas hard copy BC**.BMP
Image hard copy Bi***.BMP
Hard copy of specified device BD****.BMP
Hard copy of image + specified device |BA™**.BMP
Window screen | Detailed description of screen WINDOW.TXT
information Sprite information WINDOW.TXT
Canvas hard copy wWC**.BMP
Image hard copy Wi+ BMP
Hard copy of specified device wD*** BMP
Hard copy of image + specified device | WA**.BMP
Comment information COMMENT.TXT
Parts information PARTS.TXT

(*** indicates that a screen number between 1 and 1024 will be added automatically.)

* Files are output to the “¥DOCUMENT" directory contained in the
Project directory.
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4.2 Outputting Data From the Image Display Screen to a Printer/File

When is this function used?
e This function is used to output image display screen data such as images, devices, image

+ device, and canvases to a printer or file.

1. On the Screen menu, select [Screen Preview] and then [Image]] , [Device ),

[image + Device]] , or Canvas] .

2. The image display screen for the “Image”, “Device”, “Image + Device”, or “Canvas” is dis-

played.

= Image - [B-3 Operator panel] u
File{[F] View(Y]

Directories:
a:\debug

File Hame:
| * bmp

4-5down.bmp = a\
4-5up.bmp = debug
4-6up.bmp

Cancel

Save File az Type:
[BITMAP

Specify the drive, directory, and file name to which the data is to be output.

Clicking on writes the data to the file as a bitmap.
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4. To output the data on the image display screen to a printer, select | on the File menu.
5. The printer to be used can be changed by selecting | Print Setup | on the File menu.

5 See Section 4.1.3.

6. To reverse the image output to the printer or file, place check mark next to Iﬁeverse Outpﬂon
the File menu.
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4.3 Examples of Printing

The following are examples of printing when a document is created.

[Example of project title printing]

Filename: B: ¥ASGOTP¥UC A detailed
Created: 95/08/10 Mitsubishi..., —————description of
the project title

[Project Title] specified on
AB70GOT Demo Screens the Common

$eﬁ|ngs menu

[Explanation] is printed.
Demo-screen explanation of basic AB70GOT monitor functions,
multilanguage format, and processing speed enhancement.

-

The file name,
the date on
which the fle 1
was created, /
and the person
who created
the file are
printed.

[GOT Type] A870GOT-TFT, STN
[Screen Switching Device]

Base: O-FF RO Window: O-FF

[System Info]
Write: O-FF D100 Read: O-FF R100
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[Detailed description of base screen]

Filename: B: YAS8GOTP¥UC
Created: 95/08/10 Mitsubishi....

Base: 3: Operation-Panel Screen

[Explanation]
In addition to essential switches, lamps, and panel meters, the panel provides enhanced alarm-list
display, numerical displays, comment displays, and component displays. The panel can also dis-
play BMP image data obtained through a scanner or other device.

[Base screen (hard copy of screen image)

Filename: B: YASGOTPY¥UC
Created: 95/08/10 Mitsubishi....

Base: 3: Operation-Panel Screen

[Screen Image]

Image [B 3 Operator panel] i‘
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[Example showing printing of a list of base screen titles/window screen titles/parts screen titles]

Filename: B: YASGOTP¥UC
Created: 95/08/10 Mitsubishi....

[Base-Screen Title Listing]
1. Initial Screen
2. Demo Menu Screen
3. Operation Panel
4. Multlanguage
5. Fast Data Display

[Window-Screen Title Listing]
1. Production Conditions
2. Tank A Coolant-Water Temperature Control Graph
3. Tank B Coolant-Water Temperature Control Graph

Filename: B: ¥YASGOTP¥UC
Created: 95/08/10 Mitsubishi....

[Component Title Listing]
1. Manual Buttons
2. Manual Buttons
3. Manual Buttons
4. Processing Work
5. Processing Work
6. Processing Work

O WP N =
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[Sprite information (list)]

[Sprite information]

Base 3: Operation-Panel Screen

Numerical Displays
20. Device; 255-FF-D1 (16B+-)
22. Device; 255-FF-D2 (16B+-)

Comment Displays
27. Device; 255-FF-M9033 (16B+-)
28. Device; 255-FF-M9033 (16B+-)

Lamps

Device; 255-FF-M9032 (16B+-)
Device; 255-FF-M033 (16B+-)
Device; 255-FF-M9031 (16B+-)
Device; 255-FF-M9033 (16B+-)
Device; 255-FF-M9033 (16B+-)
Device; 255-FF-M9031 (16B+-)
Device; 255-FF-M3033 (16B+-)
Device; 255-FF-M9032 (16B+-)
Device; 255-FF-M9033 (16B+-)

Device; 255-FF-D11.7 (16B+-)
Device; 255-FF-D11.6 (16B+-)
Device; 255-FF-D11.5 (16B+-)
Device; 255-FF-D11.4 (16B+)
Device; 255-FF-D11.3 (16B+-)
Device; 255-FF-D11.2 (16B+-)

Filename: B: YASBGOTP¥UC
Created: 95/08/10 Mitsubishi....

Position; 062, 188-157, 219
Position; 274, 188-369, 219

Position; 022, 262-389, 277
Position; 020, 302-387, 397

Position; 032, 440-055, 463
Position; 064, 440-087, 463
Position; 096, 440-119, 463
Position; 128, 440-151, 463
Position; 160, 440-183, 463
Position; 192, 440-215, 463
Position; 224, 440-247, 463
Position; 256, 440-279, 463
Position; 288, 440-311, 463
Position; 320, 440-343, 463
Position; 352, 440-375, 463
Position; 384, 440-407, 463
Position; 416, 440-439, 463
Position; 448, 440-471, 463
Position; 480, 440-503, 463

[Sprite information (detailed)]

[Sprite information]

Filename: B: ¥ASGOTP¥UC

Created: 95/08/10 Mitsubishi....
Base 3: Operation-Panel Screen

Numerical Displays

20. Device:
Condition:
Format:

255-FF-D1 (16B+-) Position: 062, 188-157, 219
ON/255-FF-M100 Magnification: 2 * 2
Signed decimal/6 digits/no fraction/right/zero Red/normal/blink

Operation: AND &HOFFF >>5&  ($$*250)+50
Display: 1. Red/Normal/Blink (Comparison)

22. Device: 255-FF-D2 (16B+-) Position: 274, 188-369, 219
Condition: ON/255-FF-M101 Magnification: 2 * 2
Format:  Signed decimal/6 digits/no fraction/right/zero Red/normal/blink
Operation: AND &HOFFF >> 5  ($$*250)1+50
Display: 1. Red/Normal/Blink - (Comparison)

Comment Displays

27. Device: 255-FF-M9033 (16B+-)  Position: 022, 262-389, 277
Condition: OK/255-FF-M110 Magnification: 2 * 2
Display:  OFF. Red/Normal/Blink .

Tank B Coolant-Water Temperature Abnormal

28. Device: 255-FF-MQ033(16B+-)  Position: 020, 302-387, 397
Condition: ON/255-FF-M111 Magnification: 2 * 2
Display: OFF. Red/Normal/Blink

Tank A Coolant-Water Temperature Abnormal
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5. Error Messages

This section explains error messages which may appear when data is transmitted or printed, and
the steps that should be taken to solve the problem.

5.1

Error Messages During Data Transmission

Message

Cause

Solution

Check communications cable.

Data cannot be exchanged normally
between the computer and GOT.

Check cables and cable connections,
and make sure the equipment is con-
nected correctly.

Reduce data size.

The size of the project data being
downloaded exceeds the size available
for use by the user in the GOT.

Referring to the built-in memory informa-
tion, reduce the size of the project data
being downloaded so it is smaller than the
available user memory in the GOT.

Input password is not corect.

The password specified when data was
uploaded did not match the password
registered in the GOT.

Specify the password correctly.

Please verify password.

An attempt was made to upload data
from a GOT for which a password has
been registered, without specifying the
password first. '

Specify a password before uploading the
data.

Turm on memory card access
switch.

An attempt was made 1o access a
memory card with the memory card
access switch on the GOT off.

When accessing a memory card, make
sure the memory card access switch on
the GOT has been tumed on.

Memory card is defective; please
replace.

There is a hardware problem with the
memory card.

Replace the memory card.

Please install memory card.

No memory card has been installed.

Install a memory card.

The memory card has been installed
incorrectly.

Install the memory card correctly.

Cancel write protect function.

An attempt was made to write datato a
memory card with the write protect
function on.

Turn off the write protect function for the
memory card.

Specified data does not exist in
GOT.

When data was uploaded, a screen
number was specified which does not
exist in the GOT.

Specify a screen number which exists in
the GOT before uploading data.

An attempt was made to upload data from
a GOT in which no project data exists.

Upload data from a GOT to which project
data has been downloaded.

Hardware is defective; please
replace.

There is a problem with the GOT hard-
ware.

Contact your nearest service center or
dealer and describe the problem.

5.2 Error Messages During Printing

Message

Cause

Solution

(The error sent from the printer
driver being used is displayed.

)

Take whatever steps are necessary to
solve the problem, based on the mes-
sage sent from the printer driver.
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Appendix

Appendix 1. Processing Times for Downloading and Uploading

Appendix 1.1 Processing Times for Monitor Data

This table shows the processing times required for downloading and uploading monitor data.
These should be used as a guide when downloading or uploading data.

item No. of Screens Processing Time (seconds) Data Size (bytes)
Downloading Base screen 1 19 1628
4 39 7880
8 77 16208
16 115 32848
Basescreen 16+ | 4 138 33000
window screen
16 158 35308
Uploading Base screen 16 79
Base screen 16 + | 16 94
window screen

Appendix 1.2 Installation Times for the OS Program and Communications Driver

Installation

Name of OS program/communications driver time (sec.) Notes
OS program ‘Basic OS 900
System monitor functions OS 270
Circuit monitor functions OS 210
Communications | Bus connections 45 Install the commu-
driver nications driver of
RS-422 and QC24 connections 45 your choice.
MNET Il connections 50
MNET 10 connections 50
C24 and UC24 connections 40
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Appendix 2. RS-232C Cable Connections Diagram

This shows the internal connections diagram for the RS-232C cable used to connect the com-
puter and the GOT. (The diagram shows a D-sub 25-pin RS-232C interface on the computer

side.)

Computer .. Got

Pin No. : E Pin No.
Fa[_1 : : 1_jFe
e I e Sl N T
o ! : )
i e N s o
DSR[ 6 F——— & _|DSR
se 7 —_/\— —>
DTR|_20 : : 2 o™

Shield

(1)When a D-sub 9-pin cable is used as the RS-232C interface on the computer side, a 9-pin &
25-pin converter connector is required.

(2)If the RS-232C interface connector on the computer side is a half-pitch connector, a half-pitch
> 25-pin straight converter cable (connector) is required. Please check the instruction manual
for your computer, and if a half-pitch <> 25-pin straight converter cable is required, have this
type of cabie on hand for the interface.



IMPORTANT

(1) System settings should be set up so that protective devices for the sequencer and safety circuits are
installed externally.

(2) Printed circuit boards contain components that are susceptible to static electricity. If handling printed
circuit boards directly, the following precautions should be taken:

(M Make sure people and work benches or tables are grounded.
@ Never directly touch conductive components or electrical parts of the product.
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